
Last quarter, Ortho2 went through 

something many of you have also 

experienced in your careers – a software 

conversion. In August, we transitioned from 

a custom built Customer Database (CDB) 

to Salesforce for tracking our tickets (aka 

correspondence) with you, our orthodontic 

partners. This was no small feat, as we have 

used the CDB for 30 years, but the time had 

come for a change and I’m pleased to report a positive outcome.

The CDB was created in 1992 in Paradox for DOS, a relational 

database management system to track information on our OneTouch 

(also DOS) customers and contained four tabs: bio/address, phone 

numbers, sales info, and customer call info. Similar to Ortho2’s 

product line transitioning from OneTouch to ViewPoint (Windows), six 

years later, in 1998, the CDB was converted from DOS to Windows 

using Microsoft Access and Microsoft SQL Server. The CDB continued 

to expand and contains 24 tabs today, as well as other areas of 

integration such as the Ortho2 Webstore. Some CDB additions over 

the years have included:

•	 Order tracking and triggering of internal processes

•	 Tracking software and hardware used, as well as services 

provided

•	 Document archive

•	 Users Group Meeting information including attendees, their 

selected classes, and more

•	 Focused tabs for various teams including New Customer Care 

(NCC), Network Engineering, and Custom Projects

Before making the switch, the CDB amassed nearly 2 million calls 

logged (1,786,392 to be exact) – wow! – with the most calls logged 

by a specific customer at 10,515. Let me know if you think that was 

you!

The CDB also saw us transition from supporting approximately 

900 individual users at its inception to more than 24,000 users 

(orthodontists and their teams) today!

For 30 years, the CDB served us well but as technology marches on, 

we knew we needed to make a change. After a period of exploration 

into several options, Salesforce was selected as our next customer 

management system. Being a leader in the space, Salesforce was an 

excellent fit for today and into the future.

But our journey isn’t over, as our ticket tracking was just one of the 

24 tabs mentioned. We will continue to find new homes for all the 

information currently stored in the CDB in the coming months so we 

can continue to deliver the best service and solutions to you. 
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Our Software Support Team fields a lot of calls asking if we can help log people out of Edge Cloud to free up a license. This 

can happen if you forget to log out in one location, and you are in a second (or another) for the day. Setting up an auto-

logout is a shortcut to ensuring this won’t happen.

There are two ways to accomplish this task. The first 

way is to click User Options in the Tools tab of the 

Home ribbon bar. In the General tab, click Enable 

Auto-Logout, then type in the number of minutes 

the computer should be inactive before logging out 

of Edge Cloud. Click OK. If you use this option, you 

will need to set it up on each computer in your office.

The second way to set up the auto-logout feature 

is through the editors, and when you do the task 

this way, you set up the feature per operator. Select 

Editors in the Tools tab of the Home ribbon bar, then 

search for the Password Policy editor. If you have the 

proper security clearance, you can type in your username 

and password to access this editor.

Click Add to create your new policy. Type a name for the 

password policy, and enter a description that will help 

you select the appropriate policy for your Edge Cloud 

operators. We recommend creating a policy for each group 

of operators in your office, i.e. financial group, front desk 

group, or clinical team.

Then, check Enable Global Auto-Logout, and enter the 

number of minutes of machine inactivity to wait until the operator is logged out of Edge Cloud automatically. Continuing to 

use the computer for other applications outside of Edge Cloud, such as word processing, does not count as inactivity. Click 

Save.

Open the Operators editor. Again, you must have admin access to use this editor. You will need to assign each operator a 

Password Policy. Under Role and Security, use the Password Policy dropdown to choose the password policy group you set 

up in the step above. Click Save. Using the auto-logout policy this way means that no matter what computer the user is on, 

Edge Cloud will be logged out automatically. 

Edge Cloud’s Auto-Logout Policy 

Mother of Pearls Conference	 October 7-8, 2022

Pacific Coast Society of Orthodontists/	 October 27–30, 2022 
Rocky Mountain Society of Orthodontists

Midwestern Society of Orthodontists/Southern 	 November 3-5, 2022 
Association of Orthodontists/Southwestern Society 
of Orthodontists

COME VISIT US AT THESE FALL MEETINGS

Join us for the 39th annual Users Group Meeting in Las 
Vegas! The meeting will take place February 23-25, 2023 
at Planet Hollywood. You can view the speakers, class list, 
learn more about the Game Night Party, and everything  
you need to know about the Users Group Meeting at  
ugm.ortho2.com. 

Register online at www.ortho2.com/ugmregistration. If you 
have questions, contact Kim Barker, Meeting and Event 
Coordinator at 800.678.4644 or ugm@ortho2.com.

Each of the more than 40 classes are designed for every 
member of your team – from the doctor, to the treatment 
coordinator, even the marketing coordinator and clinical 
team member. The diverse group of presenters includes 
Ortho2 team members, industry-leading doctors, and 
consultants.

WHAT YOU’LL LEARN

USERS GROUP MEETING
FEBRUARY 23-25, 2023 | LAS VEGAS

REGISTRATION IS OPEN



MESSAGING WITH EDGE CLOUD
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Sending instant messages in Edge Cloud is a quick and 

easy way to communicate between your team members 

and other professionals. There are many features within 

messaging that can save you time during your day. 

You can access your instant messages in two ways: on the 

Dashboard or in the Message Center. If your messages 

aren’t already on your Dashboard, add them by clicking 

Widget Library next to the Home ribbon bar, then click 

Messaging. This is a read-only option for your messages. 

Optionally, open the Message Center from the Home 

Ribbon bar in the Messaging tab to view messages. Here, 

you can read, respond to, or start a new message. In 

addition, you can see the messages you have sent to other 

operators.

High Importance Option
Enable the High Importance option to flag a message as 

high priority. If you receive a message flagged with High 

Importance while you are logged into Edge Cloud, or if you 

have an unread high importance message when you first log 

in, the message will pop onto the top of your Edge Cloud 

screen so you can take care of it right away.

You can set each message you send to default as High 

Importance if you wish. Open User Options from the Tools 

tab of the Home ribbon bar. Select Messaging, and either 

toggle on or off the Default High Importance option.

Creating Quick Messages
Also in the Messaging User Options, you can create Quick 

Messages to insert standard text you use frequently into 

your messages, helping you save time. In your User Options 

window, click the Messaging tab, then click the Add button. 

This inserts a box under the Quick Message heading. Click 

inside that box and type the text you want as your quick 

message. You can add more by repeating this process. When 

you are done, click OK.

Now in the Message Center, click New Message. Right-click 

in the message body section of the New Message window 

where you would like to insert text you have previously 

saved, and hover over Quick Message. Then select from 

your Quick Message list. You can edit the quick message 

text if needed.

Setting up Message Groups
Use Message Groups to easily send an instant message to a 

specific group of Edge Cloud operators. When you send a 

message to a group, each team member that is included in 

the group will receive the message. 

You can create groups in one of two ways. The first is 

through the Editors. Open the Editors from the Tools tab 

of the Home ribbon bar and open the Message Groups 

editor under the General heading. Click the Add button 

under Message Groups to add a new group; give the group 

a Name. Select an operator name, then use the “>“ and 

“<“ arrows to add or remove the operator from the group. 

Now when you go to select message recipients, notice that 

message group names are preceded by a group icon.

The second way to set up Message Groups is in the 

message itself. When you click To in a new message, select 

the operators, then use the “>“ arrow to add operators to 

the group. Once you have all the operators selected, click 

Add Group in the top right corner of the Select Recipients 

window. Give this group a name and click OK in the Group 

Name window. 

Adding Patient Links to Messages
If you are sending a message about a specific patient, you 

can include a link to their patient folder within the message. 

In the message body, right-click where you would like to 

include a link to a patient folder, and select Link Patient. If 

a patient record is already active, that patient’s information 

will be loaded automatically. Otherwise, you use Fast Find 

to search for the patient to work with. After you send the 

message, the recipient can click the link to open the patient 

folder. 

Sending Messages to Professionals
You can also use Edge Cloud’s Message Center to send 

messages to the professionals you collaborate with. There 

are two qualifications for this to work: a professional 

record must have a valid email address to be available for 

messaging, and that email address must be registered to 

use your Edge Portal Premium application to retrieve the 

message. 

When you go to send a message to a professional, instead 

of clicking To, click Prof... to bring up a Fast Find window. 

Type in all or part of the professional’s name, and use the 

results to find your recipient.

In addition, messages received from professionals via Edge 

Portal are saved in the professional’s correspondence 

history. If the message included a patient link, a copy of the 

message is saved in the patient’s correspondence history as 

well. 



A smile can change someone’s day, from the moment you 

answer the phone and with every step in an office. You 

never know what people are going through, or how much 

one kind act can leave an impact on someone and inspire 

them to come back. It’s cliche but it’s true! Your mindset 

reflects back and affects everything around you. Setting this 

as a standard for your office can make or break a new start! 

Here are four reasons why improving your mindset affects 

your practice:

1.	 How do you greet people over the phone? Are you 

aware of whether your tone and attitude is motivating 

your undecided patients to feel welcomed to your 

office? 

When you’re greeting a patient on the initial call, it’s 

ideal to have an upbeat and perky attitude. They can 

tell if you’re smiling through the phone! This is an easy 

way to uplift any conversation. Even if you’re sad and 

you motivate yourself to smile, over time you learn 

that you have more control over your emotions and 

attitude than you originally thought. We don’t always 

have good days, but choosing to readjust is a powerful 

skill we should all integrate into our daily lives and 

practice. Shake off the jitterbug, do the dance instead! 

Make sure you’re fully engaged and present with the 

conversation. Active listening and enthusiasm is the 

perfect way to transition into your new patient call 

script. That is when you address the who, the what, 

the when, the where, the why, and the how. The how 

brings it all together.

2.	 Have you made a connection with your patient? How 

kind were you? Do you think your patient feels safe to 

express their needs from the office?

Knowing your patients’ needs is very important. 

Find out what they are looking for to make sure you 

address their needs for creating the smile that they 

want. When you address people using the feel, felt, 

found technique, this creates a level of trust between 

you and your patients. Here’s how it works: You tell 

them you know how they feel, that you have felt how 

they feel, and you have found a solution to that issue, 

thus creating the emotional connection to them you 

are looking for. In a world where we don’t trust the 

institutions around us, the only real metric for trust is 

human connection. To be educated in this field, you 

have to prioritize empathy for the change people want 

to undergo and why. 

3.	 Did you educate your new patient on the value of all 

that’s included for a proper smile assessment? Did you 

create an importance in setting an appointment and 

excitement to get to meet your new patient and them 

to meet the doctor? 

Be knowledgeable and know your craft! People 

don’t buy what you sell, they buy what you believe. 

Educating your patient on the details and solutions to 

the needs they just communicated to you can secure 

you a new start. Ask “Have I answered all of your 

questions?” or “Do you have any other questions?” 

Set high expectations so your patient knows you are 

prepared for the impact you are about to have on their 

life. Most importantly, understand your doctor’s dance. 

You both have to be on the same rhythm!

4.	 Are you ready for the day? Do you keep your office tidy 

and refreshed? Is the flow of your office comfortable 

and soothing? 

First impressions are the deciding factor to securing 

the image you just developed. Remember their 

FOLLOW UP WITH YOUR 
UNDECIDED PATIENTS

Contact Info: cjugovic@gmail.com • 954.383.3566

Cathy Jugovic is a meticulous and 

detail-oriented individual, and enjoys 

analyzing complex information. Having 

run two successful orthodontic practices, 

she knew she had a passion for helping 

people maximize their potential and 

profitability. She will be presenting at 

the 2023 Users Group Meeting.

About the Author
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By the time you get to the end of a new patient evaluation, 

your practice has invested a significant amount of time 

and many costly resources (think digital X-rays, camera, 

hardware, software, clinical supplies, staff time, and 

doctor time to name just a few) in seeing that patient and 

providing a high-quality new patient experience. Although 

carefully laying the groundwork for a treatment decision 

at the time of the exam can certainly decrease the number 

of undecided patients, it is also critical to have a strong 

tracking and follow up protocol in place for those patients 

who were undecided at the time of the exam. 

In my years of providing remote practice analysis reports 

for Ortho2 offices, I continue to find a surprising number of 

these valuable patients falling through the cracks in many 

practices. I believe part of this, is a mindset that we might 

be bothering the patient/parent when we follow up or seem 

pushy because we call. I actually see not following up as a 

disservice to the patient/parent since many questions may 

go unanswered. Scheduling a follow up phone call (two to 

three days after the exam) can give you the opportunity 

to answer questions that come up after the exam. You 

can even create a procedure code and actually schedule 

the phone consult into the TC schedule. Just remember 

to block any reminders you send from that procedure 

code. If you prefer you can set up a morning or afternoon 

appointment and use Tasks or To Do to remind you of the 

need to call.

The great news is that Edge Cloud and ViewPoint have 

many tools and reports that can help support your follow 

up system and improve the percentage of patients that 

convert to starts. Since so many reports are status driven, 

the first step may be to clarify the statuses used for 

undecided patients. For status to be used as a tracking tool 

it is important to realize that status needs to be changed 

at the end of the exam to whatever next step the patient/

parent has decided on. So a patient who scheduled their 

start would be SCH start scheduled. A patient going into 

pre-treatment observation would have their status changed 

to OBS or whatever you use. It can be helpful to set up an 

Appointment Kept Workflow that prompts you to change 

the status.

Any undecided patient would have their status changed 

to the appropriate status. Whatever you might call them in 

your practice (Will Call Back, or Undecided for example) I 

have found that having clear statuses makes follow up very 

easy. You might include the following statuses: 

•	 WME for Will Call Missed Exam

•	 WCR for Will Call Records (if you have a separate 

records appointment)

•	 WCS for Will Call Start (for those that are ready to 

schedule their start appointment)

•	 WC2 for Will Call Phase 2 (which is a great group to 

look at when the practice is a little slower) 

•	 WRF for Will Call Referred to GP/Perio

•	 WCP for Will Call Pending (for those patients/parents 

who are waiting for a set date in the future to get 

started. For example: patient will start when insurance 

begins in January or when another sibling completes 

their treatment). 

I’ve also had offices have @WChild and @WCAdult for 

patients who you want to receive an email blast from the 

office twice a year. These separate statuses allow you to 

follow up on a targeted group of patients.

You will also want to create matching Recall Procedures 

for each of the statuses you decide to use. Being able to 

put these patients on a specific recall in the future can be 

Undecided Patients continued on page 15

Contact Info: joyfulchange@comcast.net • 804.310.2361

Natalie Beaton has more than 30 

years of hands-on experience as a 

Treatment Coordinator and Financial 

Administrator. She works exclusively 

with Ortho2 clients to maximize their 

use of the Edge Cloud and ViewPoint 

systems in all critical practice areas.

About the Author

IMPROVE YOUR MINDSET,  
IMPROVE YOUR PRACTICE

Improve Your Mindset continued on page 15



Scenario #2: Another client donated a scoreboard to a local 

school because the orthodontist knew one of the coaches 

extremely well. Part of the arrangement was that at least 

once at every game the scoreboard would display signage 

thanking the orthodontist and the practice for donating 

the scoreboard. This definitely resulted in an increase in 

community referrals.

Scenario #3: This orthodontist grew up in the community 

where he opened a practice. He was friends and 

schoolmates with several of the local dentists and was able 

to shift all their referrals to his practice off the strength of 

their shared history.

These three examples are easy. They were natural 

connections that resulted in opportunity. But what if you 

don’t have all those natural connections? Then you must 

go out and make them happen and that is where referral 

marketing comes in. Think about it this way:

1.	 Your current connections could eventually refer 

patients. This does not mean that 100% of people 

you communicate with will refer, but after 38 years of 

referral marketing consulting, we can tell you that if you 

throw a net out you will absolutely capture referrals.

2.	 The number of touchpoints you have are important. 

How many times do you interact with a certain 

connector that can support your practice? Whether it’s 

a school principal, referring doctor, or influential mother 

in the community, touchpoints are directly proportional 

to how many referrals will occur. They will not all 

come at once and they will not all be steady. But as 

opportunities arise the practice will benefit.

3.	 Consistency is a key in connectivity. Who do you 

connect with? What opportunities might occur in the 

future? How often do you connect with them? How 

many touchpoints are you getting? Are you consistent?

If you have identified certain connections that may be 

beneficial in the future, and not everyone will be, then you 

must be consistent in your communication, touchpoints, and 

referral marketing strategies.

Summary
Connections are more important than almost any other 

single factor in orthodontic practice success. Some practices 

have been fortunate to build large patient bases where 

families simply refer other families. Others have the majority 

of their referrals coming from general dentists who respect 

them and like working with them. Still, others have found a 

way to access and connect with the community. 

Based on our belief that orthodontics will become 

increasingly competitive, we recommend that you continue 

to access all three areas. You may not need them today, but 

you don’t want to end up wishing you had done it tomorrow. 

Just because a practice is successful doesn’t mean it’s time 

to take your foot off the accelerator. 

THE POWER OF CONNECTION

Let’s assume for a moment that we can agree that no one 

is successful all on their own, and there are always other 

people that help us along the way. If you don’t subscribe to 

this theory, let me simply point out that you need a dental 

team, an attorney, an accountant, an estate planning or tax 

attorney, and, perhaps, 

consultants. 

So, at least for the 

moment, let’s agree that 

no one is successful on 

their own. This brings up 

a key question: who is 

it best to connect with and how will those connections help 

you to achieve your vision and the success that you have 

always wanted? Furthermore, how will your connections 

help you to maintain that success and not have it slip away 

or fall behind?

Connectivity
As an orthodontist it makes sense to think about 

connections. The most obvious connections are the 

orthodontic team and your advisors. But we need to go 

beyond that when it comes to practice success and referral 

marketing.

There are three groups that you need to connect with in 

a very powerful way for referral marketing to either be 

successful or reach its potential. Consider the following 

groups:

1.	 Patients and parents. In a general sense, we often 

advise orthodontists to think of parents as part of the 

practice. We even advise having a separate parent 

referral marketing program that includes calling to 

thank any parent that refers another patient or family, 

having contests and gifts, having regular 30-day email 

communication pieces to augment the brand of the 

practice, etc. For the kids, the most obvious form of 

referral marketing is the fun programs they enjoy as 

they receive treatment.

2.	 Referring doctors. Many orthodontists haven’t put 

in the time or effort with referring doctors and then 

simply subscribe to the theory that they don’t refer 

anyway because “they do all of the orthodontics”. 

However, by analyzing data collected in the 

Orthodontic Products/Levin 

Group Annual Orthodontic 

Practice Survey this year, we 

found that approximately 

$3.6 billion of revenue 

is referred annually to 

orthodontic practices by 

general dentists. This is a 

massive amount of revenue that most practices want 

to access. In doing this it becomes essential to have 

a referral marketing program that connects to the 

referring doctors.

3.	 Community. This is the hardest, most dispersed, and 

most expensive form of marketing, but it can still 

produce an excellent result. Most of the community will 

not be interested in orthodontics. However, community 

branding is important in creating awareness, helping 

patients like the practice, and maintaining enough 

current and future patients to build and maintain 

success.

As you can see, these are three distinct areas that must 

be continually targeted and evaluated. But the goal is 

connectivity to the right people. For example, here are 

several examples from our clients.

Scenario #1: One of our clients has a strong relationship 

between the orthodontist and a local school principal. The 

orthodontist is the one that gives all the talks on all aspects 

of dentistry including orthodontics. They also sponsor the 

PTA and several other programs and sports teams from that 

school. This has resulted in an ongoing stream of referrals 

of students from the school that seems to just continue 

indefinitely. 
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Roger P. Levin, DDS is the CEO and Founder of 

Levin Group, a leading practice management 

consulting firm that has worked with over 

30,000 practices to increase production. A 

recognized expert on orthodontic practice 

management and marketing, he has written 

many books and articles and regularly presents 

seminars. He will be presenting at the 2023 

Users Group Meeting.

Contact Info: rlevin@levingroup.com • levingroup.com

About the Author

Connections are more important 
than almost any other single factor 
in orthodontic practice success.



INSIDE ORTHO2
Information about the people of Ortho2 and the resources available to you as a member

VISUAL HELP ROUNDUP
If you haven’t taken the time to review the visual help videos on our website, now is a great time to do so! There are a 

variety of topics that you can choose from – ranging from a quick overview to a full in-depth explanation. 

Each quarter we’ll highlight a set of videos so you can become familiar with the content that is provided to you. This quarter 

features videos about insurance. These videos include topics such as:

•	 Creating an Insurance Detail

•	 Running Insurance Forms

•	 Submitting Insurance Claims

•	 Scheduling Insurance Forms

•	 Using Electronic Insurance

•	 Insurance Reports

To view these videos, log in to support.ortho2.com, then click Product Help > Visual Help > Edge Cloud > Insurance. If you 

have a topic you’d like to see covered in a Visual Help video, email ortho2support@ortho2.com. 

ORTHO2 ANNIVERSARIES
Congratulations to these Ortho2 staff members who celebrated anniversaries during the third quarter of 2022.
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CAREER MILESTONES AND DEVELOPMENT
Jasmine Snell started as a Front End Developer on July 5. Jasmine comes to Ortho2 from Santa Fe College where she 

worked as a developer for more than ten years. Welcome aboard Jasmine!

Welcome Samantha Armstrong to the Software Support Team! Samantha joined Ortho2 on July 25 as a Software Support 

Representative. She is currently working toward completing her bachelor’s degree in software engineering at Iowa State. 

We’re glad to have you with us! 

ON A PERSONAL NOTE
Congratulations to Nicole Gibson, Software Support Representative, on her marriage to Jack Cook on July 22! We wish you 

many years of wedded bliss!

Congratulations to Joe Skluzacek, Software Developer, and his wife Courtney, on the birth of their daughter Leah Marie! 

Leah was born on July 22, weighing 7 pounds, 6 ounces, and was 20 inches long. 

HELP US HELP YOU
Please be prepared to provide your customer number, practice name, and office location when you call our support teams 

for assistance. You can find your customer number in Edge Cloud by clicking File > About. If you use ViewPoint, you will 

find your customer number by clicking the Help menu and choosing About. Please be sure to provide this information—and 

repeat your phone number—when leaving a phone message requesting support. 

Thirty-Five Years
Sara Harbacheck

Seventeen Years
Michelle Kinnaman

Fourteen Years
Cal Rebhuhn

Thirteen Years
Judy Denny

Eleven Years
Brent Jacobsen 

Steve Mahan

Ten Years
Rachel Gildersleeve

Nine Years
Wesley DeShaw

Eight Years
Nathan Hemmings  

Jorge Rios

Four Years
Darcy Dakovich

Two Years
Jeff Brockway  

Marley McDonald 

Nicole and Jack
Leah Marie
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MEET THE TEAM – PRODUCT DEVELOPMENT
The Ortho2 Product Development Team does everything from creating and updating our practice management softwares, 

to maintaining our data center, and investigating and implementing new UI/UX concepts. This quarter, we are featuring 

Software Developers Tony Kooima and Joe Skluzacek.

What do you really do here at Ortho2?

TK: I’m a Software Developer and I work on enhancing and 

improving the functionality of our software.

JS: Software Developer working on Edge Cloud and web 

apps.

What’s fun/what do you enjoy about your current job?

TK: I enjoy that my job is challenging and requires me to 

constantly learn new technologies.

JS: I like working with emerging technologies as well as 

great people.

What do you want our users to know about the Product 

Development Team?

TK: We’re doing our best.

JS: We’re always thinking of what’s best for the customer.

Joe Skluzacek

Vacation destination: Ireland to 

play some great golf courses, see 

some amazing views, and hit up a 

few pubs along the way.

Three people I would like 

to have dinner with: Gary 

Vaynerchuk, Logan Paul, Elon 

Musk

My role model: My Dad. He worked 40+ years at the 

railroad and hardly complained. Got out with a great 

retirement and shows what hard work can get you.

I can’t go a day without: Technology 

What are you listening to right now? Jack Harlow or the 

country music my wife forces upon me

Favorites

Team: Iowa State

Software Program: VS Code

Movie: The Color of Money 

Tony Kooima

Vacation destination: Canoeing and 

camping in the Canadian boundary 

waters.

Three people I would like to have 

dinner with: Ernest Hemingway, Sean 

Connery, Mickey Mantle

My role model: My father

I can’t go a day without: Breakfast. 

It’s the most important meal of the day. 

What are you listening to right now? The Revivalists

Favorites

Team: Twins, Vikings, and Cyclones, in no particular order

Software Program: Ortho2 Edge Cloud, obviously

Movie: Die Hard

CONTACT US
Phone

800.678.4644 (Sales) 

800.346.4504 (Support)

Website

www.ortho2.com 

 

Newsletter Submissions 

editor@ortho2.com

Email

accounting@ortho2.com 

admin@ortho2.com 

engineering@ortho2.com 

ideas@ortho2.com 

orders@ortho2.com 

ortho2support@ortho2.com 

sales@ortho2.com 

ugm@ortho2.com

Social Media

facebook.com/ortho2 

youtube.com/ortho2systems 

twitter.com/ortho2systems 

linkedin.com/company/ortho2 

instagram.com/ortho2systems 

blog.ortho2.com 

ortho2.uservoice.com

HOLIDAYS
Our corporate office is closed on the following holidays:

New Year’s Day 

Memorial Day

Independence Day 

Labor Day

Thanksgiving Day 

Christmas Day

If a holiday falls on a Saturday, we observe the holiday on the prior Friday. If a holiday falls on a Sunday, we observe the 

holiday on the following Monday.	

The Friday after Thanksgiving, Christmas Eve, and New Year’s Eve are optional holidays. We offer limited support on those 

days.

RETRAINING
Have you hired new team members since your original software training? Has someone on your team taken on new 

responsibilities? Do you feel you might not be taking advantage of the enhancements that have been added over the years?

Ortho2 offers many options for refreshing your knowledge of old features and informing you of new features, but do you 

want to be able to set your own agenda to meet the specific needs of your practice?

A retraining — either in your office or over the Internet — addresses all these issues. To learn more and to schedule one for 

your practice, contact your Ortho2 Regional Manager today at sales@ortho2.com or 800.678.4644. 



Undecided Patients continued from page 6

especially helpful with your Will Call Referred (put them on 

an estimated date to follow up) or Will Call Pending (put 

the patient on a December recall just prior to when the 

insurance goes into effect.) 

To get an idea of the current state of your active undecided 

patients, set up a subgroup where Has Appointment = No. 

You will then want to run an undecided status report. Click 

Reporting > Patient > Patient List. Check off all the statuses 

that you are using for all you undecided patients and select 

the subgroup for no appointment scheduled. Click run. This 

will mean that any undecided patient with a recall scheduled 

will not show on this report. Therefore, the number of 

patients on your report is what I think of as your active 

undecided list. Divide this number by average monthly 

number of new patients seen in the last six months. Having 

this at about 1.5 times or below makes the list manageable. 

Anything above that, there is work to be done. If you are 

below .5 times you may just want to be sure that patients 

are not being put into a never treated status too quickly 

or that follow up has not been completed. This is a great 

percentage to look at on a monthly basis.

If this list has a large number of patients that need follow 

up, you may want to consider a mass mailing or email. I have 

found that breaking this up into separate groups of children 

and adults can work well especially if you are sending a 

special offer for patients who get started. You may want to 

place any adult patient in the never treated or will call email 

adult status once you have sent the letter. This will take them 

off what I think of as your active undecided patients list. 

This can cut an unmanageable list down to a reasonable size 

fairly quickly but still allows follow up with the patients.

Having the statuses and recalls set up this way means that 

on the first of the month you can generate a report of each 

of the status groups for undecided patients or choose the 

undecided statuses you need to follow up with. You can also 

generate a report of all the undecided pending patients 

that are due for follow up that month. To run that report, 

go to Report > Appointment > Recall Report. Set the Start 

Date to the first date of next month and the End Date to the 

last date of next month. Click View. To run all the past due 

undecided recall patients, run the same Recall Report but 

change your dates to Start Date to 12 months ago and End 

date to today.

I wouldn’t want to forget Subgroup Widget (Edge Cloud)/

Subgroup List (ViewPoint). These tools are a great way 

to access your undecided lists and follow up during any 

available time. For example, by using your subgroups, 

you can focus on contacting parents of children that were 

undecided. To do that you could set up a subgroup with 

your will call back statuses and an age range of less than/

equal to 18 and work on contacting the parents.

Whatever schedule of contacts you chose to set up for your 

undecided patients, consistent and timely contact is what 

is going to help convert more of your undecided patients 

into orthodontic treatment. Isn’t it great to know that Edge 

Cloud and ViewPoint are there to support that process? 

expectations of you. Verbiage and personal appearance 

go hand in hand. This goes for the office, too. There’s 

always an opportunity to make any space feel like an 

escape. A theme is essential to maintaining this kind 

of feeling. Dental work can be intimidating for people 

and one bad experience can frighten them from coming 

back in a timely manner, or at all. Music can aid in 

creating a sense of calm in your office. Circling back, 

your attitude!

Providing education and value is going to give your new 

patient what they need in order to choose your practice. 

Preparation, love it or hate it, is key to all successful 

endeavors in life! Embrace your Practice Consulting Services 

knows what it takes to connect with your new patient. When 

it comes to your practice, preparing yourself and your staff 

to connect with new patients starts at the welcome call. 

We look forward to presenting this topic at the Ortho2 Users 

Group Meeting! See you there! 

Improve Your Mindset continued from page 7

INSIDE ORTHO2
Information about the people of Ortho2 and the resources available to you as a member
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SERVICE EXCELLENCE
We invite you to recognize Ortho2 employees by submitting an Extra Mile form. The form is available online from the 

Contact Us page of our website. Our goal is to uphold our tradition of excellence in customer service, and with our Extra 

Mile program, you can let our employees know when you appreciate their extra effort. We encourage you to submit an 

Extra Mile form whenever an Ortho2 employee goes the extra mile for you. The recognition is valued by the recipient and 

is acknowledged by our management team. We continue to look for better ways to serve you. Thank you for helping us 

recognize excellence. 

CHAT SUPPORT
Do you need to call into our Support Team for a question, but it’s difficult to wait on hold, even for a few minutes? Ortho2 

has you covered! Use our chat support to get in contact with us. When you use the chat support feature, you will be added 

to the same queue as phone calls. You can choose to chat with the Software Support, New Customer Care, or Network 

Engineering Teams. 

In Edge Cloud, you can find links to chat support through the Help menu. In ViewPoint, click the Help button in the bottom 

right of the Daily Activities menu.

OUR FEEDBACK FORUM
Ortho2 brings you UserVoice, a powerful feedback forum that allows you to easily tell us what you think! Now you have 

the power to connect with us, make suggestions for enhancements, vote on your favorite ideas, and watch them become a 

reality.

Log into UserVoice through the Ortho2 website. Visit support.ortho2.com > Forms/Requests > UserVoice. Login with your 

user name and password. You are ready to go!

There are five product enhancement forums: Edge Cloud, Edge Animations, Edge Imaging, Ortho2 Users Group Meeting, 

and ViewPoint. You can search existing suggestions and enter your own. Vote for your top enhancements and check back to 

see which are getting the most votes. You can even add comments to suggestions and read comments from other users and 

from Ortho2. 
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